
Computer application                1prepared by the super visior :- Najla 

Kadhim                               

 

 mail-E 

 is one of the online services it's one of the most modern means of 

communication. it's used to exchange messages between users of the network and 

can attach files with messages containing documents, sounds and images must be 

of the transmitter and receiver letter e-mail address. 

 

 mail-Edvantages using of  

 Easy and fast sending of messages. -1 

 .You can send a single message to multiple destinations in the same time -2 

  .-Messages can be stored 3 

 .You can print the messages-4 

- You can attach many types of files with e-mail message. 5 

- Available free of charge by several companies, the most important: 6 

  G mail service from Google. 

  Yahoo service from Yahoo.       

  Microsoft Live Mail service. 

 

mail Spam-E 

The spam label applies to messages that are sent electronically and are spam, such 

as news spam messages. The actual difficulty is how to stop and never receive 

them again. 
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How to create an email on the Yahoo website 

1- Open a web browser and visit the link to the email Yahoo      

WWW.yahoo.com 

2-Click on the word email and click on the sign in 

3-You will see a registration box containing some requirements including: 

First name, last name, email address, password, phone number, date of birth 

(day, month, year), gender and then click on follow-up will send you a code 

on the phone Check to make sure your mobile is hot and you have to enter it 

in the box in front of you and then press Continue. 

Now will welcome you in your new email, but you will find in front of the 

new mail page. 

 

: mail account (Yahoo)-Steps Creating Your E 

 
1- Open the internet explorer               

   

 

 

 .http://www.yahoo.com :address the Write 

 
 

2- Click on the “ Sign in ”. 

     

http://www.yahoo.com/
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Enter in Code 
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The contents of the email list 

1- Compose: This is where you are going to compose a message. 

Inbox: A box that stores or saves received messages..2- 

Drafts: Saved messages..3- 

4- Sent: A box that stores messages.  

5-Spam : The spam label applies to messages that are sent electronically and are 

spam, such as news and spam messages.   

6- Trash: deleted basket.    

Folders: Sets in which the emails are divided.       .7- 
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mail service provider to the -is the address given by the e mail address-e

account holder, and can be changed and modified as the account holder 

wishes. Usually, account holders use addresses indicating their identity, such 

as their name, numbers, and symbols. E-mail must not be the same as any 

other address, it must be unique from other addresses, which is why the 

service provider and after determining the address by the account holder 

searches whether there is another similar address, or if the address is unique 

The system will be called If not, the system informs the user that it rejects this 

address and asks them to replace it or make some modifications to it. There is 

a general version of the e-mail address as soon as you see it known directly 

that this is the address of a particular person or entity and this format is 

(name @ Host) The account holder is authorized to specify the name before 

the @ sign, but what comes after the host name indicates The most popular 

email providers are Gmail.com, Yahoo.com, Hotmail.com, and many other 

providers  

mail consists of-E    
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Part I I @ Part I 

       Whereas  

Part I: a code chosen by the owner of the title. 

Symbol@: is used to connect the two parts. 

Part II: is a provider of e-mail service name. 

              ali@yahoo.comAn example of the mailing address  

To run the Internet browser program, the following follow 

…………..       All Programs     …………..     Internet  Explorer. Start 

  Or double-left-clicking on the icon diamond( Internet Explorer) on the desktop. 

 

 

- Internet Search engine: 
 

1- Google search engine. 

2- Yahoo search engine. 
 

1- Google search engine                         
 

the following: 
 

 

 

 

 

mailto:ali@yahoo.com
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.Yahoo search engine -2   

 
the following: 

 

 

 

 

 

 

 
 

Microsoft 

Office 
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Power 

Point  

2007 
 

 

Using Microsoft PowerPoint 
  

The PowerPoint program uses computer technology to transform ideas and 

projects to presentations fun and active as in the field of education, training 

and product marketing and sales. 

 

PowerPoint is different from the document because the document is agroup of 

pages while PowerPoint consists of a group of slides can be displayed on a 

computer screen or through your monitor or turn them into Web pages for 

display on the network. 
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Features Power Point program  

 
1. design and display slides containing text, images and movies and sounds. 

2. format text (font type, color and size). 

3-Drawing Lines and boxes and other forms. 

4-Inclusion of information from other programs to slides. 

5-delete and re-sequence of slides. 

6-application movements on various objects in the slides. 

7-Control of the way of slides show. 

8-print slides on paper. 

9-deploy presentations in the form of Web pages. 

 

 

You can open PowerPoint from: 
 
Click on Start, All Programs and then Microsoft Office and then Microsoft PowerPoint and the 

following window  will appear: 
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                     Use the Microsoft Office 

Click on the icon to open the choices.  

                                                               
1. New – select if you want to create a new presentation. 

2. Open – select if you want to open an existing presentation. 
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3. Save – select if you want to save a presentation already created or for 

the first time saving. 

4. Save As – select if you want to change the name or file folder . 

5. Print – select if you are ready to print your presentation. 

6. Prepare – select if you are preparing to document or distribution and 

you want to check agreements with other versions of PowerPoint. 

7. Send – select if you send an email copy or fax copy. 

8. Publish – select if you want to package it to be burned to a CD;  

9. Close – select when you ready to close this document and leave 

.PowerPoint open 

 

 
 

  

-:Tape" of the following tabs "consists   
 

"" tab, you will find here all commands display as buttons, it supports a Home-1

variety of tasks, including copies  
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And-paste, and add slides, change the slide layout, and format the text and the 

appointment of his site, and search and replace text. 

 

"from tables,  -" tab Here is everything you might need to put in the slide Insert-2

pictures and graphics .Diagrams, charts and text boxes to sounds, hyperlinks, 

headers and footers. 

"" in which you can choose Completed segments form includes Design-3

background design, fonts, color scheme, and then  tab Customize this format. 

 

"" tab Here is all animation effects. The basic movements are easier Movements-4

to add to the lists or Charts. 

  

"egment " in which you can specify the color of a pen or a certain sSlide show-5

of the start of which tab. You can also record narration, And a review of the offer 

quickly, and make some other preparatory tasks. 

 

"tab, find the spell checker and research services. Mark team have  Review"-6

used illustrations  Comments To review the presentation, and then see these 

comments. 

 

"" tab, you can make a quick switch to a view "page notes," and show grid View-7

lines, or All open presentations organization in the frame.. 

The status bar as shown in the bottom of the display screen PowerPoint introduce 

us information such as slide number and the name of the design template . 

Applied to the slide that is displayed and the display buttons and a sliding zoom in 

/ zoom out to enlarge or view slide 



Computer application                14prepared by the super visior :- Najla 

Kadhim                               

 

Resized. Clicking buttons minus (-) and plus sign (+) as well as to accomplish the 

same thing . 

 

 
 

 

 

 

 
 

 

 

 

 

-:Presentation  

Microsoft PowerPoint may be formed from single slide or multiple slides which in 

turn may contain texts, sounds, and graphics can be post an sound and mobility to 

texts and objects.   

 

-:Slide 

Is the unit that make up the presentation and where can writings images, objects. 

 

Display buttons 

Are the buttons on the bottom of the program screen from the left side in the in 

formations  bar and then clicking the lift mouse button and Display where 
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you can through the display buttons determine how the slide show and these 

buttons  represent three main ways slideshow. 

And each way view has a certain style, namely. 

. 1- normal supply 

Slide Sorter View .-2   

Slideshow.-3 

 
  
And you can access them in a second way as part of the group the "View" tab, 

click "methods of presentation offers" then 

We choose the right offer, as in the following figure 

      

 
   

 -:Notes part 

Notes part is the lower part in normal view shows the phrase (to add notes),when 

you write your notes that you want to accompany what slide. 

  

 
 

Create presentation 
 

 1 - Create a presentation using the Blank Presentation 
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Click the Microsoft office button click New, and then  -:The first way

click Blank and recent bottom of the molds, and then double-click the 

offer down empty empty set up, as in the figure 

 

from Quick Access  new clicking on the-by left -The second way:

Toolbar as in Figure. 

 
 

******************************************************************************* 
 2- Create a presentation using the installed templates 

. templates Define the installed 

They are files that contain the styles in a presentation, in clueing the 

type and size of fonts, and design of the back ground. 

You can create presentation by using the installed templates Perform 
the following steps . 
Click Microsoft office ,Click New ,and then Click the bottom of the 
installed templates. 

 

 
  

Create presentation 
 

 1 - Create a presentation using the Blank Presentation 
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Click the Microsoft office button click New, and then  -:The first way

click Blank and recent bottom of the molds, and then double-click the 

offer down empty empty set up, as in the figure 

 

from Quick Access  new clicking on the-by left -The second way:

Toolbar as in Figure. 

 
 

******************************************************************************* 
 2- Create a presentation using the installed templates 

. Define the installed templates 

They are files that contain the styles in a presentation, in clueing the 

type and size of fonts, and design of the back ground. 

You can create presentation by using the installed templates Perform 
the following steps . 
Click Microsoft office ,Click New ,and then Click the bottom of the 
installed templates. 
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Dealing with the slide 
 

inclusion of new slide -1 
   

Insert a new slide empty, select the slide you want to insert a slide and then do one 

of the following actions: 

 

tab as in  click the new slideFrom the "Home" click the "slices", -A  

Figure.      

 

 
 

B -Right-click on the current slide menu appears and choose a new 

slide as in the following figure. 
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C – From the keyboard Click on (Ctrl) key with (M) key. 
 

 Delete slide - 2  
To delete a slice, select the slide that you want to delete and do one of the 

following actions. 

A- From the home page, click the slide part, click Delete. 

 

B- Right-click on the current slide menu appears and choose Delete 

slide. 
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C- Press on the key delete or Backspace  From the keyboard to 

DELETE the slide.  

 

Copy, cut (move), paste the slide -3  

Select the slide you want to copy and do one of the following actions:- 

A- Right-click the selected slide, and then click Copy .     

B- From the home page tab in part clipboard click above the copy 

button, or paste button . 

C- press on CTRL+C to copy and press on CTRL + X from the 

keyboard. 
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Paste slide-4 
 

After a Copy command or the Cut command to the slide , you have to use the 

Paste command and to do this command, click the slide that you want to be 

followed by the copied slides or cut do one of the following actions. 

1-Right-click on the slide that you want to be followed by the copied 

slides or cut, and then click Paste. 

2-From the home page tab in the clipboard part, click the Paste 

button . 

3-From the keyboard press( CTRL + V ). 

 

 
 

******************************************************************************* 
Hide slide -5 

Select the slide you want to hide and do one of the following actions: 
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A-Of the "slide show" tab in the "set up", click "Hide slide," 

 as in the following figure. 

 

 
 

B- Right-click the slide that you want to hide, and then click to hide 
slice.  

Hidden code slide    with slide number appears inside, next to the 
slide that you have hidden. As in Figure 

 
 

Hidden slide 
 
 
 

slide remain in the file, even though it be hidden during the  -: Hint

presentation Run. 

 
******************************************************************************* 

Repeat slides -6 

Select the slide that you want to repeat them and do one of the following actions:- 

A-press the keys(CTRL+D)OF the keyboard. 

B-Right-click the slide that you want to repeat them, and then click 

Duplicate Slide As in the following figure 
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.Add Features of the slide-7 
 

are set of formatting choices that include sets of (colors Features 

Features, lines Features and features of the effects). 

Selecting Background and Format for Slide Click on the Design Tab and the following 

screen will be displayed: 

 

 

 

 
 

 
 determines the form of slide and identifies  -: Slide layout

elements that can be contained in the slide, such as text box, image, 

tableland others. 
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addition kinetic and sound effects to slidesIn -8 
 

In order to make the presentation more attractive and the impact on the 

public, you must be to add some Kinetic effects and audio it so the 

audience does not feel bored. Effects that can be added to the 

presentation. 

1-Slide transitions . 

2-Kinetic and audio effects. 

 
Add transitions between slides-1 

is the kinetic effects that can be applied at the  Transitional phase

transition between the slid and the other, such as the transition from slide 

The first to the second tranche at the moment can make the second 

tranche appear on the screen from the bottom or top or on the diagonal 

former curtains or boxes etc ... and you can also control the speed of the 

transition effect for each slide, you can also add sound. 

Add transitions between slides carried out the following procedure:- 
 
Click on Animations Within the range Transition to this Slide. 
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To appoint a speed slide transitions:- 
 

Click on Animations Within the range Transition to this Slide. 

, the group was transferred to this transitions speedTo appoint slide 
segment, click the arrow next to the speed stages 
Transitional, and then select the desired speed. Click the tab Speed share-
speed box and select the appropriate speed which is(Slow, medium, fast). 

 
dd sound to the slide transitionsA-9 

Within the Animations tab, in the group move to this other advice evil, click 
the arrow next to the transfer of voice, and then do one Both of the 
following. 

To add a sound from the menu, select the sound you want 
To add a sound that does not exist in the list, select another voice, select 
the voice that you want to add, and then click OK. 

 
Slideshow when a mouse click-11 

  Progress within the slice tab, select the box when a mouse click. 
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set The timing of the slide show12- 
Progress within the slice tab, select the Automatically After check box and 
then enter the number of seconds you want the appearance of which slide 
on the screen. 

 
 

 
 
 

You can apply different transitions between slides and you can transition 
phase itself to all the slides in your presentation and so Bannagr( Apply to 
all slides) 

 
 

 
 
 
 
 
 
 
 

Save the presentation 
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After you create your presentation and write in it needs to be saved to 

keep him permanently and save the file for the first time, you will be 

prompted to give 

Form and to conduct conservation follow one of the following steps: - ppt 

 Melv.oicon name for the file extension PowerPoint 

Office of the menu button, click Save. -1 

2-From the quick access bar tools Click the Save button . 

In both cases, a special dialog box appears to conservation through:- 

Type the file name 

Select where to save the file 

Click Save button 

 Save a file in the form of a PowerPoint presentation ready 
pps power display in the form of ready-sliced file, which is its extension ppt 
you can save the file in PowerPoint, which is an extension 
The advantage of this type of file that is ready to go as soon as double-
clicking the icon file it does not open (point show) 

PowerPoint program, but it is running a presentation and start a slide show 
Mbeshraa became like an executable file and beForm 
To make the save, follow these steps. 
Office of the menu button, click Save as. 
Private conservation as the dialog box appears. 
Of the dialog box 

Type the name of the file when the file name option .-1 
Select where to save the file when the option to save the .-2 
When "power point show" Select the type of conservation and be -3 

Save as type option. 
  Click Save button.-4 

 
-:Run the slide show 

Click on View Within the range presentation Views Choose slide show . 

 


